# Table of Contents

## Overview ............................................................................................................. 4

## Download and Install SoftChalk ........................................................................ 4

**Ask for the Key** ................................................................................................. 4
**Download SoftChalk** ......................................................................................... 4

## Create SoftChalk Content .................................................................................... 7

**Overview** ........................................................................................................... 7
**Save a Lesson** ................................................................................................... 7
**Content Creation** ............................................................................................... 8
  * Paste from Word .................................................................................................. 8
  * Format the Content ............................................................................................ 9
  * Working with Heading Styles ............................................................................. 10
  * Insert Page Breaks ............................................................................................ 11
  * Preview the Lesson ............................................................................................ 12

**Insert Hyperlinks** ............................................................................................... 13
  * Link from Text .................................................................................................... 13
  * Link from an Image ........................................................................................... 13

**SoftChalk Style Properties** .................................................................................. 15
  * Banner Style ..................................................................................................... 15
  * Banner Titles ..................................................................................................... 16
  * Modify the Footer ............................................................................................... 17
  * Table of Contents Options ................................................................................ 18
  * Navigation Options ........................................................................................... 21
  * Page Names ....................................................................................................... 22

**Insert Media** ....................................................................................................... 23
  * Insert Images from your Computer ................................................................. 23
  * Insert a Video from the Video Server ............................................................... 26
  * Insert an Audio File from your Computer ....................................................... 27
  * Insert Images using Media Search ................................................................... 28
  * Insert Videos using Media Search .................................................................... 30

## Publish Content to eCampus .............................................................................. 31

**Publish Your Lesson** ............................................................................................ 31
  * Set up Publish Account ...................................................................................... 31
  * Publish to an eCampus Course ........................................................................... 35

**Replace an Existing Lesson** ................................................................................ 37
Overview

SoftChalk is a content development software program the DCCCD provides instructors and employees to create eCampus class content. SoftChalk makes it easy to include interactive learning activities, rich media and tests in one easy to navigate and attractive package. Once the content is developed it is easy to publish directly into eCampus.

Download and Install SoftChalk

Ask for the Key

You will need to send an email to Helpdesk (helpdesk@dcccd.edu) requesting the SoftChalk key. They will provide you with the License Key and License Name.

Download SoftChalk

- Navigate to http://softchalk.com

- Click on Get Your Free 30-Day Trial.
• Fill out the form.
• Click **Submit**.

**Download SoftChalk Trial**

Thank you for your interest in the 30-day free trial of SoftChalk.

- Windows installation (91 MB)
- Macintosh installation (72 MB)
- Installation guide, .pdf (687 kb)
- User guide, .pdf (6 MB)

• Download the correct version of the software.

**NOTE:** There is a User guide and an Installation guide you can also download.
• Select **Run** and go through the steps to install the software. You can accept the defaults.

**NOTE:** For help with the installation, please download the SoftChalk Installation guide from the Download SoftChalk Trial page shown on the previous page.

Once the software is installed, you will need to input the License name and License key.

• Select **Help/Enter License.**

• Enter the **License Name** and **License Key** received from Helpdesk.

• Click **OK.**

**Note:** The **License Name** and **Key** are available on the Faculty tab in eCampus.
Create SoftChalk Content

Overview
You can use SoftChalk to create content from scratch, or copy and paste in existing content. To create content from scratch, just type in the window like you would a word processor.

Save a Lesson
Each time you open SoftChalk it will provide a blank project page. When you first save a new project, SoftChalk will create a folder for your content.

- Open SoftChalk by double-clicking on the icon on the desktop or from the Start/Programs/SoftChalk Create 8/Create 8 link.
- A blank project will load.
- Select File/Save As.
- Navigate to the desired folder.
- Name the lesson. **You cannot use spaces in the filename.**
- Click **Save**. A folder will be created for all the files.
NOTE: to open as existing SoftChalk lesson, select File/Open Recent and select the lesson, or select Open Packaged Lesson for a zipped lesson, or select Open and open any HTML file in the unzipped folder.

Content Creation

Paste from Word

If you have content already in Word, you can copy and paste into SoftChalk. Most things will paste successfully, but you have to go back and sometimes re-format the content. The SoftChalk page is organized by using Heading styles. If you use Heading 1, Heading 2 or Heading 3 in Word, those will carry over to Blackboard. Styles are important, because the Table of Contents is automatically created based on the heading styles.

- Open your document in Word.
- Select all the text using Ctrl + A on the keyboard.
- Copy the content on the clipboard using Ctrl + C, or right-click and select Copy.

NOTE: For best results, remove any complex formatting such as bullets and text wrap. You can do both in SoftChalk after the content has been pasted.
Paste the content in SoftChalk by using Ctrl + V, or right-click on the SoftChalk page and select Paste.

The content will paste. Notice the word, Overview, is blue and larger than the other text. The content was a Heading 1 Style in Word, so SoftChalk also set it as a Heading 1. The next step is to check the formatting and clean it up if necessary.

**NOTE**: Save often using the Save icon on the toolbar.

### Format the Content

You can format the content like you would in Word.

- Highlight any text you want to format and use the formatting toolbar to change the font, size, color, alignment and other formatting options.

**HINT**: Try not to use a lot of different styles of fonts because it can make a lesson look disorganized and messy.
Working with Heading Styles

Your content is organized by using Heading Styles. There are three heading styles, Heading 1, 2 and 3. Use these to organize topics and sub-topics. The TOC (table of contents) is automatically created using the heading styles.

If your content is pasted from Word and the heading styles were used, they would have maintained their same heading level in your SoftChalk lesson. You can also create and modify headings once you are working in SoftChalk.

- Highlight the text you want to format as a heading. This can be text that was already there, or newly typed text.
- Select the heading you desire from the Plain Text/Heading list. The example is being formatted as a Heading 1.

The text is now formatted as Heading 1 and will appear in the Table of Contents if one is used.
Insert Page Breaks

Page breaks separate your content into different pages. One continuous page is cumbersome and difficult to navigate, so page breaks can make your lesson flow better.

- Click above where you want to start a new page.

**HINT:** Don’t have much extra space between the page break and the top of the next page. In this example, the cursor is one line above the title, “Industrial and technological advances”.

- From the menu, select **Insert/Page Break/Insert**.

A page break is inserted. Insert as many page breaks as you desire.
Preview the Lesson

You can preview the lesson in a web browser anytime you desire. If SoftChalk asks if you want to save before previewing, say Yes.

- Select View in Browser from the Preview menu.

The lesson will open in a Web browser.

The lesson is now open, but it is rather plain and there is no navigation yet. If there are page breaks in the lesson, we can only see the first page. In a later lesson we will give the lesson a Style that can include a banner, title, table of contents and navigation.

**NOTE:** SoftChalk uses the system’s default browser. The default browser has to be changed from the browser’s Internet Settings.
Insert Hyperlinks

It is easy to insert hyperlinks in your SoftChalk lesson. You can use text as your link or images. You can link to Internet sites or files.

Link from Text

- Highlight the text that will link to the file or URL.
- Click the Hyperlink button.

- If it is a file, click the Select File button and select the desired file. The file and location will appear in the URL or Selected File box.
- If it is a web page, enter the URL in the URL box.
- Be sure the box is checked next to “Open the link in a new window”.
- Click OK.

HINT: Delete anything in the box and paste the URL from the Address Box in your browser.

The link turns blue and is underlined.
Link from an Image

- Select the desired image by clicking on it once.
- Right-click on the image.
- Select **Insert Hyperlink** or click the Hyperlink button on the toolbar.

Either select a file to link to, or put the URL in the **URL or Selected File** box.

Verify “**Open the link in a new window**” is checked.

Click **OK**.

Now when the file is published, the user can click on the picture to open a file or web page.
**SoftChalk Style Properties**

The SoftChalk Style is what gives the SoftChalk lesson a polished look and a place for navigation.

- From the menu, select **Properties/Style Properties**.

**Banner Style**

There are many available Banner styles. A Banner style provides a Banner and areas for navigating the pages in the lesson.

- On the **Styles** tab, scroll through the available **Banner Style** choices.
- Select one and click the **OK** button.
Now when you preview the lesson, you are taken to a table of contents with clickable links. The next sections will show you how to add titles, edit the footer, give page numbers names and set navigation properties.

**Banner Titles**

The Lesson Title will appear in the Banner at the top of the SoftChalk Lesson.

- Input the **Title** and **Subtitle**.
- Click **OK**.
Modify the Footer

If you want to change the default Footer, you can edit the text and options.

- Edit the **Text** if desired.
- Uncheck any unwanted **Footer** options.
- Select a different **License** option if desired.

The footer in the above Style Properties example looks like this.

```
Content ©2013. All Rights Reserved.
Date last modified: August 27, 2013.
Created by the eCampus DCCCD Software Training and Support with SoftChalk
don mobile page
```
Table of Contents Options

There are three options available in the Table of Content box.

Table of Contents Page: A Table of Contents (TOC) will be created based on Heading Styles and Page Breaks. The TOC will be the opening page of the lesson.

The Table of Contents contains hyperlinks to the different pages of the lesson.
Rollover menu in a sidebar

If **Rollover menu in a sidebar** is checked, there is a roll-over menu for navigation on the side of each content page.

With a rollover menu, when you hover your cursor over a category, any contents will expand. Click on where you want to navigate to.
Dropdown menu at top of page

If **Dropdown menu at top of page** is checked there is a drop-down menu at the top of each content page in the banner area.

With a dropdown menu, when you hover your cursor over a category, any contents will expand. Click on where you want to navigate to.

**NOTE:** if you want students to move through the pages sequentially don’t use menus.
Navigation Options

There are three options available in the Navigation box.

<table>
<thead>
<tr>
<th>Arrows</th>
<th>Places navigation arrows at the top of each content page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page numbers</td>
<td>Places page numbers at the tops of each content page.</td>
</tr>
<tr>
<td>“On This Page” sidebar</td>
<td>Places an “On This Page” sidebar on content pages that contain more than one heading.</td>
</tr>
</tbody>
</table>

Hint: To create a non-cluttered look select arrows and not page numbers if you have more than 9 pages. A drop-down menu gives the user direct access to the different pages.
Page Names

Naming the pages by topic creates a more polished look for your navigation.

- From the menu select **Properties/Page Names**.

- Input the desired **Page Names**.

Now the **Table of Contents** has page names instead of Page 1, Page 2, etc.
Insert Media

SoftChalk allows you to insert many types of media to make your lesson more engaging. They offer several repositories with photos and videos. You can also easily insert media from the Digital Resource Repository.

Insert Images from your Computer

If you already have images on your local computer, those are easily inserted. If you copied and pasted from Word, any images in the file should have pasted on the SoftChalk page.

- Click where you want the image to be.
- From the menu, select Insert/Image.
- Click Select Image.
- Navigate to the file location and select it.
- Click Select.
The image loads in the Insert Image dialog box. Now you can set the alternative text, alignment, border and extra space round the image if desired.

<table>
<thead>
<tr>
<th><strong>Optimize Image</strong></th>
<th>If the image is too large (greater than 800 x 600), you will need to click Optimize Image to make it a smaller size. If the image is already a good size, the option is grayed out.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Align</strong></td>
<td>If you want text to flow around the image, select Left or Right.</td>
</tr>
<tr>
<td><strong>Border</strong></td>
<td>If you want a Border around the image, select 1-5</td>
</tr>
<tr>
<td><strong>V &amp; H space</strong></td>
<td>To add extra horizontal or vertical space around the image, select a number from the list.</td>
</tr>
<tr>
<td><strong>Alternative text</strong></td>
<td>Alternative text is required for accessibility reasons. Put in your alt text.</td>
</tr>
<tr>
<td><strong>Long description</strong></td>
<td>If you do not want the alternative text to show when a cursor hovers over the image, put the alt text here and leave the Alternative text field empty.</td>
</tr>
<tr>
<td><strong>Change width or height</strong></td>
<td>You can resize the image using either width or height. The image will automatically adjust to remain in proportion.</td>
</tr>
</tbody>
</table>
In the example, the image has Alternative text in the Long description, text will not flow around the image, there is a border of 1 pixel and there is extra space around the image.

- Select the desired settings.
- Click **OK**.

The image will appear on the page. To modify the image’s settings, right-click on the image and select **Modify Image**.

**NOTE:** If you have an image that was copied and pasted from Word, right-click on the image and select **Modify Image** to see or change its settings.

**HINT:** sometimes when you insert images you may not see them on the page. If you will minimize the file to the task bar, then click on it you should see those images. It forces the window to refresh.
Insert a Video from the Video Server

You also have the ability to insert videos. Many file formats are supported including avi, mpeg, mp4, mov and wmv. To have a video placed on the video server, please send a request to Helpdesk (helpdesk@dcccd.edu). Your video will be placed on the video server and the URL will be sent to you. You will need to ask for the video’s size if using an inline player if that information is not included in the email.

- Place your cursor where you want the video to be.
- From the menu select Insert/Media.

![Insert Media Dialog](image)

- Select Video.
- Select how to insert the video:
  - Linked file opens the video in a new window. This is a good option if you have a lot of media on the page so the page won’t take as long to load.
  - Inline player plays the video on the page. When using Inline player you should put in the width and height. That information is generally available by right clicking on the video in your folder and select properties.
- Input the Width and Height. You might have to ask tech support at LeCroy by responding to the original email with the video’s URL.
- Input the alternative description in the Describe Media for use with screen reader/assistive technology box for accessibility.
- Paste the URL in the File Path, URL or Web Movie box.
- Click OK.

You will see a placeholder on the SoftChalk page if Inline player was selected.

NOTE: If you copy the URL from a GroupWise email, the text format has to be plain text, not HTML. From the View menu, select Plain Text.
**Insert an Audio File from your Computer**

You can insert an audio file using the Insert Media command. If you noticed in the video example, audio is an option. Use the Select File to find the file. You have the option to insert it as a link or inline player.

In the example an audio file has been selected and will be played in an Inline player on the page. An Inline Audio Placeholder will appear on the page in SoftChalk.

The audio file’s player can be seen on the page when it is published or previewed.
**Insert Images using Media Search**

SoftChalk contains several media repositories where you can search for content to include in your lesson. Each repository has different licensing agreements. Please refer to each repository’s website for their policies and rules.

- Click where you want to place an image or video.
- From the menu, select **Tools/Media Search**.
- Select the **Repository** or **Repositories** you want to search. The first time you use a Repository you might have to accept their terms of use. In the example Flickr is being used to search for an image.
Click the **Configure** button.

If given the choice, click **Search Creative Commons** only. This means you do not need to ask permission to use an image.

**NOTE:** SoftChalk will remember the setting on this computer.

Input the desired **Keyword(s)**.

Select an image by clicking on it.

Click **Insert**.

Click **Close**.

The image loads on the page. You can right-click on it to modify the image.
**Insert Videos using Media Search**

You can put in streaming videos using Media Search. The most popular repository for videos is YouTube. Videos cannot have text wrapped next to them, so you need to have your cursor on a blank line.

- Click your cursor where you want the video to be.
- From the menu, select **Tools/Media Search**.

1. Click your cursor where you want the video to be.
2. From the menu, select **Tools/Media Search**.
3. Input the desired **Keyword(s)**.
4. Click the **Repository** to search.

**NOTE**: You may need to accept the terms the first time you select it.

- Click **Search**.
- You can preview a video by selecting the video and selecting **Details**.
- Select a video and click **Insert**.
- Close the **Media Search** window.

A Widget placeholder will appear on the page.
Publish Content to eCampus

You will publish your lesson directly from SoftChalk to eCampus.

Publish Your Lesson

You have to set up a Blackboard account in SoftChalk to be able to publish from SoftChalk to eCampus.

Set up Publish Account

- From the Control Panel of an eCampus course or template, expand the Course Tools menu by clicking on it.
- Select SoftChalk Publish with ScoreCenter. The SoftChalk Access Code Configuration window will load.
- Click Submit.
• Highlight the **Access Code**.
• Right-click on the highlighted code and select **Copy**.
• Return to or open SoftChalk.

• From the **File** menu, select **Save to LMS**.

• Select the **Accounts** tab, then **New**.
- Select **Blackboard**.
- Select **OK**.

- Fill in the following fields:
  - **Descriptive name**: eCampus
  - **Server address**: https://dccccd.blackboard.com
  - **Port**: leave blank
  - **Access Code**: Paste the Access Code from eCampus here. You can right-click in the field and select Paste, or click in the field and use Ctrl + V on your keyboard.

- Click **OK**.
• Click **Connect**.

If successful, all your eCampus classes should load in the Repository window. If not successful, check your Blackboard publish account settings on the Accounts tab using the Edit button.
Publish to an eCampus Course

You will publish the lesson directly into an eCampus template or course. You will need a content area to publish to already in the course or template.

- Select the course or template to publish to in the Repository window. Use the + sign to expand a folder. Click once on the desired folder.
- Enter or use the following settings:
  - **Format**: Zip
  - **Item name**: This name will appear in the content area.
  - **Link text**: Change this if you would like.
  - **Launch in new window**: Leave unchecked
- Click **Save**. It will take a few minutes then you will receive a confirmation.
- Click **Close**.

The lesson might take several minutes to load in your eCampus class depending on its size.

**NOTE**: If the Publish button is not available you have probably not selected a folder.
• The content will be in your eCampus course or template. Select “Click to view” to view the content.

• The Table of Contents loads in the window.

• Use the back button on your browser to return to the Course intro.
Replace an Existing Lesson

To replace an existing lesson follow these steps:

- Open SoftChalk if it is not already opened.
- Open the desired lesson.
- Make the desired changes and save the lesson.
- From the **File** menu select **Save to LMS**.
- If you are not connected to the eCampus server, please click **Connect**.

- Navigate to the existing lesson and select it in the eCampus Repository.
- Click **Save**.

- **Click OK.**
  
  Your content will now be replaced.

**NOTE:** for more help with publishing SoftChalk content select **Help/Help Topics/LMS Integration.**
LeCroy Center
DALLAS COUNTY COMMUNITY COLLEGE DISTRICT
District Software Training & Support
9596 Walnut St. Dallas, TX 75243